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Project management techniques are. goal-directed, and are commeonly used by
managers to help them plan, control, direct and re-plan resources for large,
complex projects. These techniques allow managers. to “foecus on specific
objectives, such as a required  completion date, and “to’ manage resources
accordingly. Situations where project management can be-used include: process re-
engineering; design of tooling” and machinery;. software development; and
construction.

Ultimately,the -objective is to establish-a plan that outlines the sequence of
individual activities or tasks. This usually involves making trade-offs with respect
to the dedication of resources and, their sequence. Quite often, when anticipated
completion schedules or.costs must-be adjusted, project managers are forced to re-
schedule “activities. Project. management techniques assist managers with their
planning activities-by identifying the trade-off between increased use of resources
and faster project completion.

PERT (program evaluation and review technique) and CPM (critical path method)
are the two most common project management techniques. CPM was developed
by J.E. Kelly, of Remington-Rand, and M.R. Walker, of DuPont, as a tool to assist
with scheduling maintenance shut-downs of chemical plants. PERT was developed
the following year for the U.S. Navy, to help manage the Polaris missile project.
Originally, PERT was more flexible in dealing with variations in lead times, while
CPM assumed that project activities could be estimated accurately. Today,
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however, differences between PERT and CPM techniques are relatively minor, and
the two terms are often used interchangeably. The term PERT/CPM will be used
here.

PERT/CPM techniques display project activities in a network diagram to help
managers focus their attention on the sequence of events most crucial for project
completion. In order to create a network diagram, the project must include
activities that not only are clearly defined, but also must be carried out in a specific
order (precedence relationships). In most situations, opportunities exist to re-order,
compress or extend the activities with the objectives of revising the program
budget or completion date.

Due to the large number of activities involved with many projects, computers are
commonly used to simplify the analysis and provide answers to ‘“what if”
questions. A variety of relatively inexpensive software packages are available.
These packages organize your project in a standard format-based on the duration
time of each activity and the sequence of activities.

THE PROJECT MANAGEMENT PROCESS

Project management using a network ' model can be separated in-the following four
steps:

e define the project

o identify activities, precedence relationships and time elements
o establish critical path

o make adjustments

1. Define the Project

Each projeet should have clearly ‘defined beginning and ending points. It is up to
the project manager to describe the project activities in terms that team members
will\ easily comprehend...Consequently, a clear statement should be created,
identifying the scope of the project, its major activities and their relationships, and
the time unit in which-the project will be monitored.

2. Identify Activities, Precedence Relationships and Time Elements

The project should then be broken down into “activities,” which represent the
individual tasks that the project team expects to coordinate. The activities will have
precedence relationships; that is, the sequence of activities is constrained because
certain activities must be completed before others can begin.
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A difficult part of this step is establishing time estimates for each activity. In
particular, at the beginning of the project, time estimates may be difficult to
establish. Experienced project managers, however, rely on a variety of sources to
determine their initial time estimates, ranging from personal experience to formal
engineering studies.

One easy method of organizing this data is to create a three column list which
includes the following: Activity, Activity Description, and Immediate
Predecessor(s). Once organized, the activities can then be translated into diagrams
that can take on any of several formats.

The Gantt chart, similar to a bar chart, shows individual activities and-the length.of
time required for each activity, with each activity depicted with a bar. The Gantt
chart often organizes the sequence of activities by listing at the top.with those that
must be completed first. While Gantt charts can be used to.display relationships
among activities for small projects, it becomes difficult. to wvisualize activity
relationships for large, complex projects when relying on Gantt charts alone.
Furthermore, it is also difficult to establish the eritical path and other important
information for managing the project solely by relying-on a Gantt chart.

To overcome these weaknesses, the PERT/CPM diagram shows the-activities as a
series of nodes on a network. An activity, shown asa node, is directly linked by an
arrow to activities that immediately follow it and depend on-its-completion. This
format makes the inter-relationships between activities immediately apparent. Both
PERT/CPM and Gantt charts are'widely used by managers to-track projects.

3. Determine Critical Path

The critical path is-defined as the sequence of activities which takes the longest
time to/complete. The critical path represents the completion time of the project. A
project.can haye more than one critical path; however, the completion time of each
of these paths must be equal.

4.. Make Adjustments

Most projects are constrained by two factors: time and cost. Since improvements
in project completion times often require additional resources at a premium cost,
balancing the trade-offs between activity cost and project completion time is an
important component of the project management process. Additional activity cost
can take many forms, including additional personnel, equipment, expedited
delivery, etc.
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Calculation of the critical path sequence permits the project manager to identify
both the activities that influence total project completion time and other activities
that can be extended without delaying the completion of the project. Adding time
to any critical path activity extends the total time needed to complete the project,
while reducing these activity times (termed “crashing”) may shorten the total time.
If more than one path is critical, the activity times for several activities might need
to be simultaneously crashed to reduce the total project completion time.

As activities on the critical path are crashed, new critical paths may be added.
Consequently, managers might be forced to deal with several different critical
paths before finalizing their project plan.

AN EXAMPLE

The following example illustrates the application of PERT/CPM techniques to a
project.

Bart is a first-year student, who plans to go skiing over Winter break. He intends to
leave the business school immediately following the mid-term exam in his
operations course, which is expected to’conclude at 12:00 noon on February 16,
1996. The trip from the business school to his apartment usually takes 30 minutes.

Unfortunately, Bart has spent<the last few.days studying for the exam, and as a
result has not prepared for his vacation. After arriving home, Bart knows that he
must wash his clothes. Ideally, he will-do three loads-of laundry, which he expects
to take four hours.”He knows-that packing, which he anticipates will take 30
minutes, must wait until he has-finished doing his laundry.

Bart also needs to go to the bank to withdraw some money and obtain travellers’
cheques for'the. trip. He expects this activity to take one hour, and this can take
place at-the same time his laundry-is being done. Finally, Bart must pack the car
and drive to the'meeting place to catch the bus; he expects both of these activities
to take 30 minutes each. The bus was scheduled to leave at 5:00 p.m., and Bart
knows that he cannot be late:

The list of activities that-Bart must complete is provided in Table 1. Note that this
table also identifies predecessor activities and estimated completion times.
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Table 1

BART’S SKI TRIP

Activity Activity name Immediate Estimated time
predecessor (hours)
A drive home — 0.5
B wash clothes A 4.0
C pack B 0.5
D go to bank A 1.6
E pack car C,D 0.5
F drive to bus E 0.5

A Gantt chart, outlining the activities together with their‘duration, start'and finish
times, is presented in Figure 1. The difficulty in using this data to-mianage Bart’s
activities is that it fails to show the relationships among the activities, the sequence
of events constraining completion of the project {the critical path), and the slack
times. In short, we know when the project staris and when it needs to be
completed, but we cannot see how the activities are inierrelated.

Figure i
GANTT LCHART FOR LART’S SKITRIR
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As an aid in analyzig the above information, it is useful to represent it
schematically as an activity-on-node diagram. To do this, we adopt the convention
of using the nodes (small squares) to represent activities and the arrows to
represent the sequence in which they are performed. An activity is a specific task
which takes time and resources. Bart’s ski trip preparation is presented in Figure 2.
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Figure 2

SKI TRIP PERT DIAGRAM
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The network diagram shows the activities which must be performed before Bart
leaves, their duration, as well as the sequence in which they must be performed.
Specifically, note that both activities C and“D must be completed before E can
begin. The diagram typically includes the letter representing the activity inside
each node, along with its activity time (duration).

Now we can begin our analysis: The first thing we do is establish.for-each activity
the earliest possible time that the activity can begin and finish; termed the Earliest
Start time (ES) and Earliest Finish time (EF), respectively.-Byconvention, for the
first activity, here A, we define its ES as zero, and record this above and to the left
of the node. The EF time is-equal to the ES plus the-activity duration time. This
time is noted above.and‘to the right of the-activity. For activity A, the EF is 0.5
hours.

Earliest Finish time (EF) =Earliest'Start time (ES) + activity duration (d)

Then, for each of the activities that follow this activity, their ES is equal to the EF
of the preeeding activity. Thus, the ES and EF for activity B are 0.5 and 4.5 hours;
for activity D 1s 0:5.and ‘1.5 hours. When two or more activities immediately
precede an activity, such:as E, the ES for that activity is the largest of all preceding
EF times. For example, at activity E, the EF for activity C is 5.0 hours, while for
activity D is 1.5 hours. Consequently, we take the greater of the two, and use 5.0
hours. We continue this way until we have calculated an ES and EF for each
activity, as illustrated in Figure 3. The EF for the last activity, F, is 6.0 hours. This
last figure is the total time to complete this project.
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Figure 3

SKI TRIP WITH EARLY START AND EARLY FINISH TIMES
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We now work backward through the diagram to establish the latest times that we
can start and finish an activity, without delaying-the whole project. These are
termed the Latest Start (LS) time and Latest Finish (LF) time for each activity. The
LF for the last activity, here F, is equal to the EF; and is recorded beside the EF,
separated by a slash. The LS for F.equals-the LF minus the.duration, here 5.5
hours. We record this figure beside the ES; separated by a slash.-In general, the LS
time is given by:

Latest Start time (LS). = Latest Finish time (LF) - activity duration (d)

For each preceding activity, the LF is equal to the\[LS of the next activity. Thus, for
activity E, the LE.1s 5.5 hours and the LS 15 5.0'hours.

If two.or more activities follow an activity;-such as activity A, we used the smallest
LS time of those activities as'the LF time of A. Thus, because the LS of event B is
0.5 hours andthe LS of D is.4.0 hours, therefore, we use 0.5 hours as the LF for
activity A-Figure 4 updates the network diagram with LS and LF data.
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Figure 4
SKI TRIP WITH LATE START AND LATE FINISH TIMES
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The final calculation is to identify the “slack™ or “float” for each activity. Total
slack is the maximum amount of time that an activity can begin late or be extended
by, without delaying completion of the entire project. Notice that the slack time for
an activity is not independent of the slack-for ‘other activities. Thus, it is not
meaningful to add together the slack times of two or more activities.

Slack =LS —ES =LF —EE

Here the only activity with any slack is.activity D, where the time is (4.0 — 0.5) =
3.5h.

Now, we find the critical path. 1t is the chain or chains of activities which have
zero slack. For the Ski Trip; this chain is A-B-C-E-F. Any lateness in these critical
activities will delay the completion of the entire project. In addition, any effort to
reduce the-total project time must.be directed first at the activities on the critical
path.

USING MICROSOFT-PROJECT
1. What Microsoft Project can do

Microsoft Project (MS Project) is a powerful software package that allows you to
plan, organize and control projects consisting of multiple activities that may be
interrelated. MS Project uses information about the project, such as activity
durations, start dates, available working time and completion dates/deadlines to
build a model of the project that you are managing.
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Using a software package, such as MS Project, provides the user with several
advantages. First, MS Project automatically organizes your activities based on the
duration times and sequences identified in the data. The data will be organized into
standard format, making it easy to share information. MS Project allows you to
view your project in a variety of different ways: Gantt charts, PERT/CPM
diagrams and calendar view. Second, the flexibility of the system allows you to
easily ask “what if” questions and perform sensitivity analysis. Third, as a project
is undertaken, management can use MS Project to monitor the overall project
schedule and completion of activities, thus permitting the replanning of activities
based on their early or late completion.

2. General Concepts

a. Creating and organizing a project

MS Project refers to all activities as tasks. Creating a project requires the user to
input the following information:

o task names/descriptions;

o duration;

o start and finish date restrictions, if appropriate;
e precedence relationships; and

o available working time:

When entering the data, time units must be consistent(e.g.; days or hours).
MS Project will use. this information to organize the project, indicating expected

completion dates; critical paths and project sequencing.

b. Scheduling activities

Activity scheduling should begin by identifying the start date of the project.
Although certain activities.may be pre-scheduled to begin at a specific date, most
will start following completion of their predecessor activities. Consequently, those
activities not on the critical path may have “slack” among them if the start dates
are flexible or otherwise delayed.

Understanding the precedence relationships is important. MS Project organizes the
project, however, this requires the user to provide accurate information with
respect to the sequencing of the activities.
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c. Gantt Chart view

MS Project has three views: Gantt Chart, PERT Chart and calendar. These
represent standardized views for project managers, each displaying the same
general information in slightly different formats. Typically, the default format on
MS Project is the Gantt Chart view. Toggling between views is done using the
View menu.

The Gantt Chart displays data in both text and graph form. The position of .the
various activities allow the user to identify the sequencing of the activities and the
expected completion date. To overcome one of the weaknesses of Gantt charts,"MS
Project identifies predecessor relationships between activities using arrows.

d. PERT Chart view

The PERT Chart view displays activities as a network'diagram. Each activity is
represented by a node (or box). Predecessor. trelationships are identified by
connecting lines. As the project progresses, the PERT Chart will display a single
diagonal line through an activity in-progress._and.crossed diagonal lines through
completed activities. The nodes display-information about the status of the
activities, including duration, start date.and completion dates.

e. Calendar view

The calendar view.displays data which allow the user to quickly identify when
particular events are scheduled, during which- days, weeks and months. This
method makes it easy to schedule resource activities, such as labor, based on
forecasted needs.

The'calendar format can be changed.to highlight particular activities. For example,
personnel.requirements can be‘highlighted to simplify staff scheduling.

f.  Critical path

Virtually every project manager must worry about the critical path. MS Project
analyzes available “slack” time and calculates the critical path(s). The critical path
can be highlighted in all three views.
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g. Evaluating and adjusting the project

After your project data have been entered, it is often necessary to evaluate the
project plan in terms of meeting specific objectives, such as completion dates. MS
Project allows managers to easily ask “what if” questions in order to evaluate the
impact of particular changes in terms of the amount of resources required and their
costs. For example, management might re-examine the original specification of
precedence relationships, and identify and evaluate alternatives. In addition, the
benefits, if any, of “crashing” activity times also can be quantified.

TUTORIAL

The following tutorial, Bart’s Ski Trip, will introduce you to project management
using Microsoft Project (MS Project). The model can be found in the Operations
Management directory on the network. The model follows the activities described
earlier. Please feel free to access the Microsoft Help, under the Help menu, at any
time.

1. Define the Project

Bart has six activities to manage-before starting his vacation: drive-home, wash
clothes, pack, go to the bank,pack car and drive to the bus. Each of these have
been listed in the Task name column in the file. Note thatthe calendar has been set
to February 16, 1996, which(is consistent with the timing of the tutorial.

2. Identify activities; precedence relationships.and activity times

We need to” establish the precedence relationships between activities and the
duration time for each activity. Fitst, set the time scale. From the Format menu,
select. the ““Timescale...” command and define hours for the major scale. Under
minor scale select minutes, and set'the count at 30. This allows us to track the
project. based on 30-minute intervals.

Next, click the “drive home” cell in row 1. Using the arrow key on your keyboard,
move the cursor one-cell to the right, under the Duration column. Enter the
duration of the activity, in this case 0.5 h. Repeat this step for each activity.

Next, we must enter the required sequence for the activities. In the Predecessor
events column, enter the immediate predecessor activity, if any. Click the “wash
clothes” cell and move the cursor with the keyboard arrow key two columns to the
right, under the Predecessor events column. Predecessor events must be identified
by row number. For, example, before Bart can start his laundry, he must first drive
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home. Therefore, in the Predecessor column in row 2, enter “1”. Table 1 provides a
summary of Bart’s activities.

Alternatively, the activities, their durations, and their precedence relationships can
be entered directly in the PERT Chart window. Switch to the PERT Chart window
under the View menu, and select Task under the Insert menu or press the Insert
key. A task box can be “dragged” with the mouse when the cursor changes to a
four-way arrow over the edge of the task box.

Activity data, including the name and duration, can be entered by double clicking
on the center of any task box, or by using the “Task Information...” cemmand
under the Insert menu when the task box is highlighted. The fields that should-be
completed are “Name” and “Duration.” The time units are denoted with “d” for
days, “h” for hours and “m” for minutes, and these must be entered, or days are
assumed. Click “OK” when finished. Precedence relationships are easily-entered
by dragging from the center of a task box to the center of its.suceessor task boxes.
Tasks can be deleted by clicking on the task box and pressing the “Delete” key;
precedence relationships can be deleted by double-clicking on the arrow and
pressing the “Delete” button in the “Task Information™ dialog window.

In addition, you can customize the information displayed in the task-boxes. in the
PERT window using the “Box Styles...” command on the Formatmenu.

3. Establish critical path

From the Gantt Chart we see that the expected completion time is 6:00 p.m. Recall
that Bart must be-ready to-go by 5:00 p.m. Under the View menu, you can select a
PERT diagram. The PERT diagram depicts the sequence of activities and the
critical path:

In otder to address this problem-facing Bart, we must first establish the critical
path,-which represents the longest sequence of activities in the project, and
therefore, has zero slacktime. MS Project can highlight a project’s critical path.

In the Gantt Chart view,-the names of the activities on the critical path are then
highlighted. From the -Format menu, select “Text Styles...” in the item to change
box, select Critical activities. In the Color box select a color (e.g. red) for the
names of the critical activities.

In the PERT view, the critical task boxes are automatically highlighted. The color
can be changed by using the “Boxes Styles...” command under the Format menu.
Either the Gantt or PERT view allows us to see that the sequence of drive home,
wash clothes, pack car and drive to bus represents the critical path.
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4. Make Adjustments

From Bart’s project schedule, it is obvious that he cannot get everything done, at
least as planned, and still get to the bus on-time. The current project plan indicates
he will be one hour late. However, recognizing this is a problem, Bart can identify
alternatives.

First, he might call his bank and have them prepare the travellers’ cheques in
advance. This new activity might require five additional minutes; he would still
have to go to the bank, but the time spent going to the bank would be reduced to
0.5 hours. Second, Bart might also reduce the amount of laundry from three loads
to two loads. Bart estimated that he would need only two-thirds the time, two
hours and 40 minutes, to complete two loads of wash. Which activity should be
changed and what is the impact?

As established earlier, the sequence of activities that is the critical path is drive
home, wash clothes, pack car, and drive to bus. Since Bart can go to the bank
while doing his wash, this activity is not critical.

We can confirm that changing this activity will not help us complete the project
more quickly by changing the time of the *“go to bank’ activity to 0.5 hours, and
adding a new activity of five minutes for phoning the bank. (Go-te'the PERT view.
First, delete the precedence arrow between “drive home” and. “go to bank™ by
double-clicking on it and pressing the “Delete” button in the “Task Dependency”
dialog window. Then, press the “Insert” key to add a new task, double click on the
center of the task box to ‘access.the “TFask Information” dialog box, and enter the
“phone bank” as the task name and “5m” for the duration. Press “OK.” Finally,
connect this task-to other tasks-in the network by dragging from “drive home” to
“phone bank” and-from “phone bank™ to-“‘go.to -bank.”)

The completion time of the project.does.not-change. Consequently, Bart does not
reduce the overall time for completing the project by calling the bank and ordering
the travellers’ cheques in advance.

The other option is_ to do-only two loads of wash, thus reducing the time of this
activity by one-third.. The cost of crashing this activity is not financial, rather only
the amount of clean clothes. By changing the duration time on this activity, we see
that this compromise ‘will allow Bart to get to the bus on time. (Go to the PERT
view. Double-click on the task box and change the duration to “2.67h.” Click the
“OK” button.) The project completion time is now 4:40 p.m.



